
What is SoftWriting

If you have notes, documents, interview notes, minutes of meetings, lecture notes, assignments or any 
other handwritten documents, SoftWriting can help you turn them into Word documents or text files, fast 
and easy. Once these documents are converted, you will be able to view and modify them using the word 
processor of your choice.

SoftWriting uses an advanced Intelligent Character Recognition (ICR) Engine, to give you the best 
possible results when converting your handwritten documents to printed text.    SoftWriting also enables 
you to review the converted documents and change or verify any words that SoftWriting is not confident 
about their accuracy.    This is a very quick process, which means that you will have your documents 
ready in no time.



What is a Character Recognition Engine

A Character Recognition Engine is a software program that examines an image containing text and by 
analyzing the image, determines what the characters are.    SoftWriting has a built-in Character 
Recognition Engine that is specifically suited to examine non-cursive handwriting. SoftWriting's Character 
Recognition Engine is special in that it does not need many samples of your handwriting in order to learn 
your handwriting and then uses this information when analyzing your documents.    Since every person 
has unique handwriting, SoftWriting's learning ability means that it can recognize handwritten characters 
exceptionally well.



How does SoftWriting work

If you have handwritten papers that you would like to convert to text file, SoftWriting is your solution.

The required process is as follows:

1. You scan your papers directly into SoftWriting or you can open files that contain your scanned 
documents (scanned documents should be in black and white TIFF format). 

2. SoftWriting will then process your documents and convert the characters into printed characters. 
3. Once finished, SoftWriting displays the document, highlighting words whose correctness is below 

a threshold confidence level. 
4. You have the ability to correct words or leave them as they are. 
5. Finally you can save the document in a format that is recognizable by most word processors.

General concepts of SoftWriting

SoftWriting's ICR learns text written by each individual and constructs a learning base for him. The 
learning base consists of two different parts: One part contains information on the particular form of each 
character written by the user. The second part accumulates information on the user's vocabulary. These 
two kinds of information are unique for every user and are useful in the ICR's decision making procedure. 
The base reaches saturation after learning a large enough sample of every character and a large enough 
number of words, respectively. This goal is achieved in several steps:

1. Three pages (about 300-500 words) of text supply information for constructing an elementary 
data base. At this point one has a not very bad data base for lower case letters.

2. SoftWriting continues to learn, enlarges its data base and improves its performance, as work 
goes on. In particular, upper case characters and digits are learnt rather slowly, as relevant 
information accumulates.

3. The user's vocabulary data base is constructed in a similar manner. 

This procedure explains why SoftWriting is expected to improve with time, until saturation is achieved.

SoftWriting is sensitive to false information supplied at the beginning of the learning stage. Therefore, 
while processing the first 10 pages (approximately), users are requested to correct carefully uncertain 
words. These corrections are learnt and specific form of each character is added to the data base. In so 
doing, the ICR is able to recognize more confidently specific character (whose form looks similar to the 
learnt one) in further encounters.



System specification

A PC equipped with an Intel 486 or Pentium (or compatible) microprocessor and configured with 16 
megabytes (16 MB) of random access memory (RAM).

· Microsoft Windows 95, Windows 98, Windows ME or Windows NT
· A hard disk with a minimum of    5 megabytes of free space 

Note You will also need space for any images you want to store.



Scanner support

SoftWriting supports most popular desktop scanners and other input devices through the TWAIN    
interface standard. SoftWriting is compatible with any TWAIN-compliant scanner that can scan in colors, 
gray or black and white between 200 and 300 dpi. 
Your scanner manufacturer supplies TWAIN drivers.



Working modes

Page Mode – displays an image of one page at a time.

Proofread Mode – displays the page image as well as the converted text and enables correction of the 
text.

Preview Mode – enables viewing of multiple pages and enables reordering of pages.



Using help

SoftWriting provides you with context sensitive help.    This means that SoftWriting senses what you are 
trying to do and will attempt to give you the required help information. Once the Help window opens, you 
can browse all the help topics available or search for a particular word using the index.

Context sensitive help is provided when you press F1 from any screen in SoftWriting. The Help window 
will open and display the most appropriate help topic.



Languages

To install new dictionaries for recognition please read the page 
http://www.charactell.com/docs/languages.htm and follow the instructions.



Registration
In order to be able to work with SoftWriting after the evaluation period expired, you need to have a 
registration number. The registration number will be given to you after you purchase the product.

If you purchased the product from our website, CharacTell will send your registration number to your 
email address. This number is also shown on your browser in the end of the purchase process.

If you purchased a CD, the registration number is shown inside the CD box.

The registration number contains 14 digits.

After you provide the registration number, you will need to approve each writer. See Profile approval and 
advanced registration for more details.



Profile approval and advanced registration
For each registration number CharacTell keeps a record that contains the number of writers that are 
allowed to use SoftWriting.

This information is shown in the Licenses tab of the "Approve writers" dialog.

Each writer who wishes to work with SoftWriting after the evaluation period expired, needs to make an 
approval. Once the writer was approved, SoftWriting will send this information to CharacTell's web-site. 
For each registration number there is a limit on the number of approved writers. You will not be able to 
approve more writers than the limit that you have for your registration number. If you wish that additional 
writers will be able to use SoftWriting, you need to buy a new license and Add it in the Licenses tab. 

To approve a writer, select Approve writer from the main menu. In the Writers tab you can click on the 
writer(s) that you want to approve, and then click on the Approve button.

If you mistakenly approved a writer, send an email to support@charactell.com.



Welcome screen

The Welcome screen is the first screen that will be displayed when you start the SoftWriting application.    
In this screen you are required to select your profile, or,    in the event that you are converting someone 
else's document, the profile of the person who wrote the documents.    You will also need to select the 
language and the case of the documents being converted.

We recommend that new users will see the demo using the demo button. The demo takes about 3-4 
minutes, and it demonstrates the concepts and the screens of SoftWriting.

If you do not have a profile or you wish to convert someone else's writing and that person does not have a 
profile, you must create a profile first.    See Create a new Writer Profile

Writer's name The name of the writer whose documents you wish to convert.    
Select your profile name if you are converting documents written by 
you, or, another person's name if you are converting their 
documents.    For each writer profile created, SoftWriting learns the 
writer's unique handwriting characteristics.

Language The language in which the documents you wish to convert were 
written in.    Initially SoftWriting will only be available in English but 
later on in other languages as well.    You will however, be required 
to teach SoftWriting your hand writing for each language you want 
to convert.

Case The case in which the documents you wish to convert were written 
in.    This can be Mixed for documents containing both upper and 
lower case or Upper for documents written only in uppercase.

Starts the SoftWriting application with the profile selected in the 
Writer's name text box.

Create a new profile

Close the SoftWriting application and return to Windows



New User screen

The New User window is used to define the name of the writer profile you are creating.    See Create a 
new Writer Profile

Existing writers These are profiles which have already been created

New writer's name The name for the new profile being created.    The name 
cannot be the same as an existing writer



Main screen - before converting to text

The SoftWriting main screen is where you will do most of your work.    The screen will appear different 
before conversion and after conversion of your documents.

Before conversion of your documents, the following buttons are available:

Start a new session and a new document

Save the converted text in Word format or standard text format

Select the profile corresponding to the writer whose documents 
you wish to convert.    See Selecting the writer profile

Open SoftWriting's online help.    See Using help

Display only one image in the work area. 

Display all pages in the work area

Load the documents you wish to convert.    See Add page to 
document

Convert the pages loaded to text and display the for 
proofreading.    See Convert to Text

Zoom in to magnify the image

Zoom out to reduce the image size

Rotate the image by 90 degrees each time

Pick the tool to add a new picture region. Such region will be 
saved as an image. After you picked this tool you can define a 
region with the a mouse drag.

Pick the tool to add a new ignore region. Such regions will be 
ignored by the recognition engine. After you picked this tool you 
can define a region with the a mouse drag.

Pick the tool to delete regions. After you picked this tool you 
can click on a region and it will be deleted.



Main screen - after converting to text

The SoftWriting main screen is where you will do most of your work.    The screen will appear different 
before conversion and after conversion of your documents.

After conversion of your documents, the following buttons are available:

Start a new session and a new document.

Save the converted text in Word format or standard text format

Select the profile corresponding to the writer whose documents 
you wish to convert.    See Selecting the writer profile

Open SoftWriting's online help.    See Using help

Display only one image in the work area

Display all pages in the work area

Load the documents you wish to convert.    See Add page to 
document 

Convert the pages loaded to text and display the for proofreading. 
See Convert to Text

Zoom in to magnify the image

Zoom out to reduce the image size

Rotate the image by 90 degrees each time

Change a word to a bullet. This can be done to the first word in a 
line.

Accept the word as correct.    If the word is colored in blue it will 
now be clored in black and the cursor will jump to the next blue 
word.    Accept is the same as pressing the <ENTER> key.    See 
Accept a suspected word

Leave the word as is and move the cursor to the next blue word. 
See Ignore suspected word for the time being

Replace the word with an image containing that word in 
handwriting. See Include word as image

Merge the word with the following word.    See Merge words

Undo the most previous merge.    See Undo merged words





Proofread screen

Once you have completed proofreading your document you can do one of the following:

Save document As... Save the text as a Word or standard text file

Save later Return to the session without saving the 
document

Add page Load another page to be converted

Reorder pages Display the pages in Preview mode where they 
can be reordered

If you have completed the documents required for learning, this screen will only have two butons:

Learn now Complete the learning of this document

Return to revise Continue proofreading the document



Document complete screen
This screen has two sections.    The first section asks you whether you want 
SoftWriting to open the saved document in your word processor application.    The second section asks 
you if you wish to stay in current session, start a new session or close SoftWriting.

Note: these two sections do not affect each other.    It does not matter whether you choose to open the 
word processor or not, you can still choose any of the three options in the second section

Open in default word processor This option will open your word processing 
application and display the document you have 
just saved.

Do not open word processor This option tells SoftWriting not to open the 
word processing application

Start a new session SoftWriting will close the current session and 
start a new one.    This is the same as clicking 
the New Document button

Stay in current session SoftWriting will not close the current session 
so you can go back and edit the document

Close the SoftWriting application will be closed 

 



Create a new Writer Profile

Any person who wishes to have SoftWriting convert their handwritten documents will be required to create 
a profile for themselves.    The profile specifies the writer's name.    Only documents written by that writer 
should be converted using this profile.    Using a profile to convert documents written by other writers will 
significantly reduce the character recognition rates

To create a new profile 

· Click the New button in the Welcome screen
· In the New User window which appears, enter the writer's name and click OK.    You will be 

returned to the Welcome screen
· Select the language and the case (mixed or upper case only) of the documents you are about to 

convert
· Click the Select button



Learning a writer's handwriting

There are a number of situations where SoftWriting needs to learn a writer's handwriting

1. When creating a new user profile

2. When selecting a language that has not been learnt before
For example: SoftWriting has learnt your English writing and now you wish to convert documents 
written in Spanish. (This feature will be available in the near future as SoftWriting supports more 
langauges)

3. When selecting a case (mixed or upper) that has not been learnt before
For example: SoftWriting has learnt your documents written in Mixed case and now you wish to 
convert documents written in Upper case

When you are in the Welcome screen and you create a new profile, or specify a language or case that 
has not been learnt before, once you click the Select button, SoftWriting will notify you that it is necessary 
to perform the activities required for learning 



The handwriting learning steps 

When you click the Select button in the Welcome screen, if SoftWriting needs to learn the writers 
handwriting, the SoftWriting wizard will appear.    The wizard will notify you of the steps required to 
complete the learning process.



Starting the SoftWriting application

To start the SoftWriting application 

· Double click on the SoftWriting icon.    Alternatively, you can open the SoftWriting application from 
the Window's Start menu by pointing to the folder containing the SoftWriting application. 

See Windows Help if you require more assistance with this operation.

Once started SoftWriting will display the Welcome screen that enables you to select the writer profile or to 
create a new writer profile.    You will need to create at least one writer profile before you can start using 
SoftWriting.

If your desired profile has already been defined, select it from the list and click the Select button to open 
SoftWriting's main window



Selecting the Writer Profile

Once started, SoftWriting will display the Welcome screen that enables you to select the writer profile or 
to create a new writer profile. 

To choose a writer profile 

· select the desired writer profile, the language and the case (mixed or upper case only) from the 
drop down list on the Welcome screen

· Click the Select button

To change the writer's profile from within the main SoftWriting window

· Click the select writer's name button  on the toolbar or choose Select Profile from the Process 
menu

For more information, see Select a different writer.
 
When you convert the images to text, SoftWriting needs to know who wrote the papers it is trying to 
convert.    Therefore, you must make sure that you are using the correct writer profile, i.e. the profile of the 
person who wrote the papers you wish to convert.



Open a new document

SoftWriting refers to the paper images you supply it, as pages, while a document refers to both the 
images and the text extracted from these images. When you start SoftWriting, it automatically starts with 
a blank new document and is ready for you to add pages either from a scanner or from a file.    You can 
add many pages to a document.

To open a new document

· Click the new document button  or select New Document from the File Menu

Tip: you can also use CTRL +N as a shortcut

Opening a new document is a little bit like cleaning out your work area



Add page to document

When you first open a new document it includes no pages and no converted text.    Before you can 
convert the contents of a page to text, you must add that page to the document.    Adding a page to a 
document can be done by scanning the page or by selecting a file containing the page.

To add a page to the document click on the Add page button or select Add page to document from the 
Process Menu.

The Select Source window will appear asking you whether you want to add the page using a scanner or 
from a file:

Note:    You can add pages to the document at any time.    Even if you have already converted one or 
more pages, you can still add more pages to the document.    When you click the Convert to text button, 
SoftWriting will convert the new pages and add the results to the previous page results.    After finishing 
the conversion SoftWriting will enter Proofread mode and display the first suspicious word it encounters in 
the document.



Select Source for adding a page

To add pages using a scanner: 

· Select the scanner option and click OK

If you need to change the scanner parameters, click the Scanner Options button.    For more information 
see Scanner Options

If you are not satisfied with the scanning results, check the Preview scanned images check box, in order 
to view the scanned gray or color images before SoftWriting turns them into black and white images.

To add pages from a file:

· Select the File option and click OK
· Find the location of where the desired file resides, click on that file name and click Open. 

Alternatively you can double click on the file name

A batch is a set of images that were scanned by SoftWriting and saved using the Save Batch menu 
option. To add a pre-scanned batch:

· Select the Batch option and click OK
· Take the batch from the batch location and click open.



Preview scanned image

The Preview screen enables the user to view the scanned images as color or gray before SoftWriting 
turns them into black and white images.    It is designed to make sure the scanning results are 
satisfactory, in order to achieve optimal recognition results.

If writing on the reverse side of the page is clearly visible on screen, check the box marked Reverse-side 
writing clearly visible on screen.    When this box is checked, SoftWriting will identify and ignore reverse-
side writing.

Do not check this box unless you can clearly see the writing on the reverse side.    This may result in loss 
of relevant information.

If you are satisfied with the scanning results, click Continue.
To re-scan the images, click Cancel and select Add Page again.



Delete a page from document

To delete a page that has been added to the document

· Select Delete Page from the Process Menu

You can also delete pages while in Preview mode

· Click on the page you wish to delete
· Select Delete Page from the Process Menu



Setting abbreviations

Abbreviation is a useful concept that lets you write fast frequently used long words. You can define 
abbreviations for such words. For example, instead of the word "miscellaneous" you can set the 
abbreviation "MC". By doing so, if you write on the paper the word MC, SoftWriting will replace all the 
occurences of the word "MC" with "miscellaneous" in the entire document.

To set an abbreviation you should:

1. Select Tools and Abbreviations from the menu. Then the Abbreviation Setting dialog appears
2. Write the short form (e.g.: MC) in the "Replace" box. Write the long form (e.g.: miscellaneous) in 

the "With" box.
3. Click on the Add button.

To remove an abbreviation you should select it from the abbreviation list and click on the Delete button.



Convert to text

To convert the pages of the document to text

· Click the Convert to text button or select Convert all pages from the Process Menu.

To convert a single page of the document to text

· Display the page you wish to convert
· Select Convert current page from the Process Menu.

SoftWriting will display the page and will color it in three cycles.    Firstly it will color it in yellow, then it will 
color it in blue and a third time in pink.    While the pages are being colored, SoftWriting is actually 
analyzing these pages and converting them to text.    Once finished, SoftWriting will enter Proofread mode 
in which it displays the page image on the top part of the screen and the converted text on the bottom 
part.



Select a different writer

When you convert the images to text, SoftWriting needs to know who wrote the papers it is trying to 
convert.    Therefore, you must make sure that you are using the correct writer profile, i.e. the profile of the 
person who wrote the papers you are trying to convert.

To select a different writer

· Click the select writer's name button  or choose Select writer from the File menu

You will need to select a different writer in one of two cases:

1. You selected a certain writer in the Welcome screen and you realize you want to convert pages of 
a different writer

2. You finished converting pages of one writer and you wish to convert pages of a different writer.

Note: You cannot select a new writer if you have already performed the add page action.    In this case 
you will be required to start a new docuemnt and add the pages again



Save document

SoftWriting enables you to save the converted text as a text file that you can then open in other 
applications such as your word processor.    The text file will be saved in either Word format or as a 
standard text file 

To save a document 

· Click the Save document button     or select Save document As... from the File menu



Remote Scanning

Sometimes you want to scan the documents in one computer and process them on another computer. 
This is generally the case when you do not have a scanner connected to your computer, and there is a 
scanner that is connected to another computer in the same local network.

To do this, you should do the following:

1. Install SoftWriting. Set the installation directory on a shared place on the local network.
2. Create an Icon on the desktop of the remote computer that execute the file softwriting.exe from 

the installation directory.
3. Run SoftWriting from the remote computer.
4. Select your writer's name.
5. Scan the pages using the Add Page.
6. Select the Save Batch from the menu, and give a name to the set of papers you just scanned.
7. Exit from the remote computer, and run SoftWriting on your computer.
8. After you click on the Add Page, select the Batch source.
9. Now you can continue as usual with the Convert to Text option.



Creating a zone

This feature will be supported in the future 

You can specify areas on your documents (zones) to specify an exact area containing an image.    
SoftWriting will not attempt to convert this area to text but it will include it in your converted document as 
an image



Deleting a zone

Once you have created a zone you can use this option to delete the zone definition 



Overview

Once SoftWriting is finished analyzing your pages and converting them to text, it switches to Proofread 
Mode whereby it enables you to proofread the document and correct inaccurate words. 

When in Proofread Mode, words that SoftWriting is not certain about their accuracy, appears in blue.    
These suspicious words can be either:

1. Words that were not matched with a word in the dictionary
2. Words that have a match with the dictionary but SoftWriting is still not certain that the word was 

recognized correctly.

The correction mode enables you to perform a number of actions.
· Accept a suspected word
· Alter a suspected word
· Alter a non-suspected word
· Ignore a suspected word
· Select a choice from the dictionary
· Include word as image
· Merge words



Accept a suspected word

Words that SoftWriting suspects were not recognized properly are colored in blue.    When you switch to 
Proofread Mode, SoftWriting will highlight in yellow the first suspicious word. 

To accept the word as is

· Click the suspected word to highlight it if it is not already highlighted
· Click the Accept button.    Alternatively, you can press <ENTER>. 

The word will change to black to signify that it is no longer suspicious and the next blue word will be 
highlighted in yellow.



Alter a suspected word

Words that SoftWriting suspects were not recognized properly are colored in blue.    When you switch to 
Proofread Mode, SoftWriting will highlight in yellow the first suspicious word. 
 
To alter the word 

· Click the suspected word to highlight it if it is not already highlighted
· Correct the word as necessary
· Press <ENTER> when finished correcting the word or click the Accept button 

The correct word will appear in the document in black to signify that it is no longer suspicious and the next 
blue word will be highlighted in yellow.



Alter a non-suspected word

In the Proofread Mode, you can alter any word even if that word is not suspicious. 
 
To alter a word
 

· Click the word you wish to alter so that it is highlighted
· Correct the word as necessary
· Press <ENTER> when finished correcting the word or click the Accept button 

The next suspected word will be highlighted.



Ignore suspected word for the time being

Words that SoftWriting suspects were not recognized properly are colored in blue.    When you switch to 
Proofread Mode, SoftWriting will highlight in yellow the first suspicious word. 

To ignore a suspected word for the time being

· When the word you wish to ignore is highlighted, click the Decide Later button.
· The word will remain blue to signify that it is still suspicious and the next blue word will be 

highlighted in yellow.

· Note:    SoftWriting will not save the text to a file if that text contains suspected words i.e. words 
colored in blue, therefore you will be required to accept all words before you can save the text to a file.    
This means that if a word is colored in blue you need to correct it, accept it as is, or click the Decide later 
button knowing you will need to come back to that word and accept it before you can save the text



Select word from dictionary

Any words which SoftWriting suspects were not recognized properly are colored in blue.    Clicking on a 
suspected word will also display a list of similar words in a listbox which will open underneath the word.    
One of these words can be used to replace the suspected word.

To select a word from the dictionary

· Click the word you wish to replace so that it is highlighted.    SoftWriting will jump to the next 
suspected word

· Note: you can use the up and down arrows to select the desired word from the listbox which 
opens underneath the suspicious word



Add word to dictionary

SoftWriting does not require that you specify that words be added to the dictionary.    Whenever you 
correct words, they will automatically be added to the dictionary.    This includes names, abbreviations etc.



Include word as image

SoftWriting gives you the ability to include parts of your handwritten page as images in your document.

For example, if you have a mathematical formula that the Character Recognition Engine cannot recognize 
properly, you can choose to include it in your original handwriting.

To include a word as an image of the original handwriting

· Click the word to highlight it if it is not already highlighted
· Click the Keep as image button

If you want to include a large area as an image use the Zoning feature.

To convert an image back to text

· Click the image to highlight it if it is not already highlighted
· Click the Keep as text button



Merge words

To merge a word with the word next to it

· Click the word to highlight it if it is not already highlighted
· Click the Merge with next button

To undo a Merge with next operation 

· Click the merged word to highlight it if it is not already highlighted
· Click the Undo merge button



Undo merged words

To undo a Merge with next operation 

· Click the merged word to highlight it if it is not already highlighted
· Click the Undo merge button



Zooming the image 

You can increase or decrease the size of the image    using the zooming buttons.

Use the Zoom in image and Zoom out image to zoom in and out of the page image.

To zoom in on the image

· Click the Zoom in button  or select Zoom in Image from the View menu

To zoom out of the image

· Click the Zoom out button  or select Zoom out Image from the View menu



Resizing the image or document

When in Proofread Mode, SoftWriting will display the page image on the top part of the screen and the 
converted text on the bottom part.    You can resize the page image part which resizes the document part 
at the same time

To resize the page image and the document

· Place the mouse cursor at the bottom part of the page image.    It should turn into a double sided 
arrow

· While the cursor is a double sided arrow, click and drag the bottom line up or down to resize the 
parts. 



Rotating images

To rotate the page being displayed 

· Click the Rotate Page button  or select Rotate Clockwise from the View menu

The page is rotates by 90 degrees everytime the Rotate Page button is clicked



View all pages in document

To view all pages in a document 

· Click the Preview button    

· When viewing multiple pages you can also use the reorder feature to reorder the pages 



Reorder pages

To reorder the pages in the document

· Click the Preview button    
· Click inside the page you want to move and drag it to the desired position.    Alternatively, enter in 

the text box under the page, the number the page should be.    The pages will immediately 
change positions according to the reorder

Note: to return to Proofread Mode, double click on the page you want to correct or click the One page 
button



User options

The User Option window lets you customize SoftWriting to suit your own needs
This window has six tabs each one containing a different group of related options.

To open the User Options window select Options.. from the File menu

In the User Options window, the tabs available are:
Scanner
Save As
File Locations
General
Text Display
Image Display
Internet

 



Scanner options
 
TWAIN Driver  SoftWriting includes two TWAIN drivers so that if one is not working 

properly with the scanner you can try the other one.    The default 
TWAIN driver is the main driver.    However, if you are having 
problems accessing your scanner, try the alternate driver to see if it is 
more suitable for your scanner

Twain GUI on  If Twain GUI is set to on when you select to add a page using a 
scanner, the scanner's program will open and you will use it to do the 
scanning 

Twain GUI off  If Twain GUI is set to off when you select to add a page using a 
scanner, you will do the scanning from within SoftWriting i.e. the 
scanner's program will not be displayed

Resolution  This is the resolution you wish to scan in. 

Colors This determines how scanning will be done.    B&W is black and white, 
Grey is for grey-scale scanning and color is for color scanning

Paper Size Select the paper size of the documents you are scanning



Save As options

You can specify whether the default file format when saving will be Word format or a standard text file.

Regardless of what you choose, you will still be able to specify a different choice when you actually save 
the file



File Location options

These specify the default locations for your files

Scanned Images This is the locations where the files of your scanned documents are 
saved

Saved Doc This is the location where your Word or text files are saved

Click on one of the file types and click Modify to change the location



General options

Suspected words

These options specify which words will be colored during the proofreading stage

Color spelling mistakes If this option is ticked, then any word not 
matched with the dictionary is highlighted.    
These will include names and other words 
which are not in the dictionary.    If the option is 
ticked off, then words which are not matched 
with a dictionary are not necessarily 
highlighted.

Color only highly suspected words  If this option is ticked,    then only words which 
are highly suspected of being recognized 
wrong are highlighted.    If this option is ticked 
off, then all words which are suspected will be 
colored in blue.    Ticking this option off will 
mean there will be more blue words to accept 
but is safer in that there will be less instances 
where words are colored in black even though 
they are wrong.

Always verify numbers If this option is checked, then numebers always 
displayed with colors, asking for the typist 
confirmation. Otherwise, only unclear numbers 
requires confirmation.

Numbers with backslash

There is an option to write a backslash preceding a number. When SoftWriting would recognize the 
backslash it will recognize the numbers better, because he would know that this is not a regular word in 
the dictionary.

The backslash should be clear - around 45 degrees. SoftWriting would accept backslash with diagonal 
between 26 degrees and 68 degrees.

Always backslash precedes numbers If this option is set, then SoftWriting would not 
search for numerals unless it finds a backslash 
as the first character in the word.

Sometimes backslash precedes numbers If this option is set, then when SoftWriting finds 
a backslash as the first character in the word, it 
will look only for numerals in such word. It will 
look for numerals also in other words.

Never backslash precedes numbers If this option is set, SoftWriting will not consider 
a backslash as a suggestion to find a number.

Number of characters to learn



SoftWriting learns by default 10,000 samples of characters. Then it stops collecting the user's characters. 
You can change this option here.

By the way, SoftWriting keeps learning the user's vocabulary for ever.



Text display options

Define the colors and font to be used on the converted text

Selected words What color to use to highlight the word that is being reviewed 
during proofreading

Font What font to use when displaying the converted text

Suspected words What color to use to highlight words which are suspected of not 
being correctly recognized



Image display options

Define the colors to be used on the image

Selected words What color to use when highlighting words on the image

Text region What colors to use when highlighting a region containing text

Image region What color to use when highlighting a region to be saved as an 
image



Internet Options

Use the Proxy Server screen to specify whether your LAN uses a proxy server to connect to the Internet. 
A proxy server is a computer on your LAN that connects to the Internet without compromising the security 
of your internal network. If you are not sure how your LAN connects to the Internet, contact your system 
administrator.



Why is SoftWriting unique

At present, SoftWriting is the only product available, which converts free formatted non-cursive (print) 
handwritten documents to text files.    Furthermore, SoftWriting's optical character recognition engine is 
the only engine that learns efficiently the individual's handwriting characteristics. 



How to improve the recognition results

Recognition rates achievable with SoftWriting vary based on a number of factors. 

Paper

· If your paper is thin and half transparent (generally paper that is less than 80 mg), you should 
write on one side of the paper. Otherwise, the writing on the other side of the paper will appear on 
the scanned image and damage the recognition results.

· The paper color should be white or yellow.

Writing

· The best recognition results are achieved when characters are separated from one another. 
SoftWriting attempts to separate connected letters. However, this task is sometimes performed 
unsuccessfully. Therefore, touching characters can reduce the recognition rate.
 

· Note that connecting characters that belong to different lines might reduce the recognition rate.

· Try to use a pen that does not produce breaks during writing.

Scanning

· It is recommended that scanning be done from within SoftWriting.    The default scanning 
parameters in the scanner options are "Gray" level and 200 dpi.    If you have problems scanning 
with Gray level, you may want to try the "Color" option.

· In the scanner options, "Twain GUI on" allow you to use the scanner software interface rather 
then the SoftWriting interface to do the scanning.    Use this option if you wish to define 
enhancements available through the scanner interface.

· If the paper is half transparent and the flatbed scanner has a black cover, the black cover will 
appear in the scanned image as spots. In such case, you should put another white paper 
between the scanned paper and the scanner cover.

Operation

· Make sure that the pages you add are upright and not rotated before they are recognized.

· For documents written in upper case only, select "Upper only" in the Welcome screen, otherwise 
select "Upper and Lower".

· Insufficient number of words in the initial learning process will cause poor results. Only words that 
appear in the English dictionary are considered in the initial learning process.

What improvements can I expect from the learning process?

The learning process comprises of two stages. In the first stage SoftWriting recognizes the handwriting 
without knowing the specific user's handwriting.    The second stage involves you proofreading the results. 
After the proofreading is done, SoftWriting will complete the learning and you are ready to use the 
software. 

Words that are not in the dictionary, e.g. names, are more likely not to be recognized properly.    However, 



once you correct these words, they are added to your personal dictionary and have a high chance of 
being recognized the next time that SoftWriting encounters these words.

SoftWriting will not recognize numbers the first time it encounters them.    However, once you correct 
these numbers, they have a high chance of being recognized the next time that SoftWriting encounters 
these numbers.



Can SoftWriting support multipule users

SoftWriting is able to support many users.    Each user will need to perform the learning process 
separately.    Then, each time someone wants to use SoftWriting, they choose their name from the list and 
the software then knows hoe to recognize their handwriting.
 



Support

If you are encountering problems when using SoftWriting, you can contact our Support department for 
technical help

Email: support@charactell.com



Sales

To find out more about CharacTell go to our web site at
www.charactell.com

or send us an email requesting your desired information
sales@charactell.com




